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About this user’s guide

This user’s guide provides instructions for using IBM® PowerExecutive” software
to manage the power and thermal needs of BladeCenter® systems and
rack-mounted servers in the data center. PowerExecutive is part of a larger
power-management implementation that includes hardware and firmware
components. PowerExecutive 1.10 is an extension to IBM Director 5.10 software.

Who should read this user’s guide

This user’s guide is for system administrators and operators using PowerExecutive
from IBM Director Console to manage the power and thermal needs of systems
and servers in the data center.

Conventions and terminology

These notices are designed to highlight key information:
Note: These notices provide important tips, guidance or advice.

Important: These notices provide information or advice that might help you avoid
inconvenient or difficult situations.

Attention: These notices indicate possible damage to programs, devices or data.
An attention notice appears before the instruction or situation in which damage
can occur.

Related information

This topic provides links to additional information related to PowerExecutive.
PowerExecutive resources on the World Wide Web

The following Web pages provide resources for understanding, using and
troubleshooting PowerExecutive and other systems-management tools.

PowerExecutive Web site
http:/ /www.ibm.com/servers/eserver/xseries/systems_management/
ibm_director/extensions/powerexec.html

Obtain an overview of PowerExecutive and links to download the product,
release notes and user’s guide.

IBM personal computing support page
www.ibm.com/pc/support/

Locate support for IBM hardware and systems-management software.

IBM Systems Management Software: Download/Electronic Support page
www.ibm.com/servers/eserver/xseries/systems_management/
ibm_director/

Download IBM systems-management software, including PowerExecutive.
Check this Web page regularly for new PowerExecutive releases and
updates.
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IBM System x® Systems Management page
www.ibm.com/systems/x/

Obtain an overview of IBM systems management.

IBM ServerProven® page
www.ibm.com/pc/us/compat/index.html

Obtain information about IBM System x, IBM eServer and IBM
BladeCenter.

How to send your comments

Your feedback is important in helping to provide the most accurate and highest
quality information. If you have any comments about this book or any other IBM
publication, use the form for reader’s comments that is provided at the back of this
publication. If the form has been removed, address your comments to:

International Business Machines Corporation
Design & Information Development
Department CGFA

PO Box 12195

Research Triangle Park, NC 27709-9990
US.A.

Accessibility

Accessibility features help a user who has a physical disability, such as restricted
mobility or limited vision, to use information technology products successfully.

Features

PowerExecutive meets the accessibility standards for Section 508 of the US
Rehabilitation Act.

These are the major accessibility features in PowerExecutive:

* You can use screen-reader software and a digital speech synthesizer to hear what
is displayed on the screen.

* You can operate all features using the keyboard instead of the mouse.

* You can choose from a variety of high-contrast color schemes and large font
sizes in the IBM Director Console.

PowerExecutive supports all accessibility features provided by IBM Director.
Keyboard navigation

This product uses standard Microsoft® Windows® and Java'" navigation keys.
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Chapter 1. Getting started

Use this topic to gain general and conceptual information about PowerExecutive.

Introducing PowerExecutive

Use this topic as an overview of PowerExecutive.

PowerExecutive is an IBM Director extension that provides the PowerExecutive
task in an IBM Director environment. The PowerExecutive task displays the
PowerExecutive Console in IBM Director Console. PowerExecutive enables you to
monitor and collect power-consumption data from BladeCenter chassis and
rack-mounted servers, manage trend data, and export data.

Additionally, the information in PowerExecutive is affected by certain events. For
more information, see [“Understanding events that affect PowerExecutive” on page

PowerExecutive task overview

Use PowerExecutive to monitor and collect power consumption data from
supported BladeCenter chassis and rack-mounted servers, manage trend data and
export data from PowerExecutive.

See the following table for information availability.

Icon m

Supported IBM Level-0 managed systems
Director objects

Supported operating ¢ Linux®

systems

Y * Windows
For detailed operating-system support information, see the
PowerExecutive documentation.

Availability Extension to the IBM Director product. You can download the

extension from the IBM Support Web site at www.ibm.com/
servers/eserver/xseries/ systems_management/ibm_director.

Required hardware or | For installation, none. For monitoring, this task only supports
hardware limitations | specific BladeCenter chassis and specific rack-mounted server
systems. For details, see the PowerExecutive documentation.

Required software BladeCenter Management extension to IBM Director 5.10 must be
installed.

Required protocols None

Required device None

drivers

Mass configuration No

support

Scheduler support No

Files associated with None
this task
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Events associated with |None, but the information displayed by PowerExecutive is
this task affected by certain events. For more information, see the
PowerExecutive documentation.

PowerExecutive terminology

PowerExecutive uses terminology that is specific to power management in IBM
Director Console.

The hardware in a PowerExecutive environment is referred to in the following

ways:

* A management server is a server on which both IBM Director Server and
PowerExecutive Server are installed.

* A rack-mounted server is a stand alone system with a Baseboard Management
Controller (BMC)

* A management console is a system on which both IBM Director Console and
PowerExecutive Console are installed.

* A managed system is a BladeCenter server that is a level-0 system (agentless) in
an IBM Director environment.

e A module is a BladeCenter component that is inserted in a bay in a BladeCenter
chassis.

* A management module (MM) is the BladeCenter component that handles
system-management functions. It configures the BladeCenter chassis and switch
modules, communicates with the blade servers and all I/O modules, multiplexes
the keyboard /video/mouse (KVM), and monitors critical information about the
chassis and blade servers.

The software and its components in a PowerExecutive environment are referred to
in the following ways:

* A chassis object is an IBM Director managed object that represents a BladeCenter
chassis whose power information can be displayed in Power Executive.

A power object is an IBM Director managed object that represents a module in a
BladeCenter chassis. Power objects can include the following BladeCenter
components:

— Power modules

— Processor blades

— I/0 modules

- Management modules
— Blower modules

— Media trays

— Midplanes

PowerExecutive components

This topic provides information about the PowerExecutive components.
PowerExecutive comprises the following three components:
* PowerExecutive Server

¢ PowerExecutive Console
e PowerExecutive database
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PowerExecutive Server

PowerExecutive Server maintains the PowerExecutive environment and manages
all PowerExecutive operations.

PowerExecutive Server communicates out-of-band with each managed system and
each PowerExecutive Console to display status and perform operations. It
communicates with IBM Director Server to provide event filtering and event
actions that support IBM Director event action plans. PowerExecutive Server must
be installed on the management server. When you install PowerExecutive Server,
PowerExecutive Console is installed automatically.

In normal cases, PowerExecutive Server communicates indirectly with management
modules by querying IBM Director Server for information that IBM Director has
already collected from the management modules. When IBM Director does not
have the requested information, PowerExecutive Server can communicate directly
with management modules through an internal communication path.

Power data is collected only while the PowerExecutive Server is running. When
you install PowerExecutive, the server starts running. It runs whenever the IBM
Director Service is running. It collects data on BladeCenter chassis and
rack-mounted servers every minute, or as configured on the Manage Trend Data
window.

PowerExecutive Console

PowerExecutive Console provides the graphical user interface (GUI) to
PowerExecutive in IBM Director Console.

PowerExecutive Console displays rack-mounted servers at the same level in the
navigation tree as the BladeCenter chassis, but rack-mounted servers will be a leaf
node. The Object Info panel for a rack-mounted server has the same basic layout as
the corresponding panel for the BladeCenter chassis.

Install PowerExecutive Console on all management consoles from which a system
administrator remotely accesses the management server and performs
PowerExecutive tasks.

PowerExecutive database

The PowerExecutive database stores information collected by PowerExecutive
Server.

PowerExecutive creates or updates its database when it obtains information that
IBM Director cannot provide. The PowerExecutive database can contain
information about BladeCenter chassis objects, power objects and historical data
such as temperature and power data over time.

The PowerExecutive database is created in the PowerExecutive subdirectory of the
IBM Director installation directory.

When you uninstall IBM Director Server, it does not remove the PowerExecutive
database unless you request that customizations be deleted during the

uninstallation of IBM Director Server.

The size of the PowerExecutive database directly correlates to the short-term
data-collection interval, the long-term data-collection interval, and the number of
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days that short-term and long-term trend data is kept. All of these values are
configurable. You can control them and the size of the PowerExecutive database by
using the Manage Trend Data window. For information about doing so, see
[‘Managing collection of trend data” on page 23

Further, the PowerExecutive database can grow very large when you are retaining
data about blade servers that have enabled the power meter.

As an example, you could have one BladeCenter chassis fully populated with 14
blade servers, each that have the power meter enabled. Assuming that the
short-term data collection cycle is the default value of 1 minute and the long-term
polling cycle is the default value of 10 minutes, then a day’s worth of short-term
data consumes approximately 1-1/4 MB of database storage. In this scenario, one
day’s worth of long-term data collection consumes approximately 126 KB of
database storage.

When the PowerExecutive database cannot expand, it deletes the oldest historical
data from the database to free up room for the new data that it is collecting.

PowerExecutive task

4

The PowerExecutive task runs the PowerExecutive GUI from an IBM Director
Console. You can use the PowerExecutive task to view and monitor power
consumption on various rack-mounted servers, BladeCenter chassis and power
objects in the IBM Director environment.

When you add PowerExecutive Console to your IBM Director environment, the
PowerExecutive task is added to IBM Director Console.

You can start the PowerExecutive task by dragging and dropping the task icon
onto the following targets:

e If the target is a blade, the display will consist of chassis containing the blade
with the targeted blade preselected.

* If the target is a BladeCenter chassis, the display will consist of the chassis with
the chassis itself preselected.

e If the target is a rack-mounted server, the display will consist of the server with
the server itself preselected.

e If the target is a group of rack-mounted servers or BladeCenter chassis, or both,
the display will consist of all chassis or rack-mounted servers in the group with
the first chassis or server in the group preselected.

If there is no target (you start the PowerExecutive task by double clicking rather
than dragging and dropping it onto a target), then the display will consist of all
BladeCenter chassis and rack-mounted servers known to Director.

You can perform the following tasks for rack-mounted servers, BladeCenter chassis
and components:

* Monitor power consumption data
* Collect power consumption data
* Manage trend data

* Export data

More information about these tasks is provided in [Chapter 3, “Using]
[PowerExecutive,” on page 15.|
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Starting PowerExecutive for all chassis objects

When you start PowerExecutive for all chassis objects in the IBM Director group
called All Systems, the PowerExecutive window opens and displays a tree of all
chassis objects on IBM Director Server.

When there are numerous chassis objects on the management server, this method
can take several minutes for PowerExecutive to start. However, the advantage of
starting PowerExecutive in this manner you can manage all chassis objects from
one window.

Starting PowerExecutive for some chassis objects

When you start PowerExecutive for only a chassis object or a group of chassis, the
PowerExecutive window opens and displays a tree of only the selected objects.

The left pane in PowerExecutive contains only the selected chassis objects, only
those chassis that contain the blade servers that have also been selected, and only
the chassis objects in a selected group. When you select a blade server,
PowerExecutive determines the containing chassis object and displays the entire
tree structure for that chassis object, not just the one that you selected.

The advantage of starting PowerExecutive in this manner is that it must obtain
information about only a subset of chassis objects instead of obtaining information
about all chassis objects on IBM Director Server. PowerExecutive starts quickly
when you use this method. The disadvantage is that you can manage only those
chassis objects that were selected when you started PowerExecutive. If you need to
manage power objects in other chassis objects or at a later time, you must start
another PowerExecutive task for those additional chassis objects.

PowerExecutive Console window

After you start the PowerExecutive task, the PowerExecutive Console opens and
provides a GUI for managing selected rack-mounted servers, BladeCenter chassis
components and power objects on the management server.

The PowerExecutive Console window contains a menu bar, a tool bar and a
graphical representation of the BladeCenter chassis component selected and power
consumption data on various power objects in these chassis objects. The
PowerExecutive window displays only those power objects in the chassis objects
for which it was started, which might not be all power objects on the management
server.

The PowerExecutive Console contains these major areas:
* Navigation pane

* Detail pane

* Trend pane

You can customize which of these panes are displayed in the PowerExecutive
Console. To do so, see [‘Customizing the PowerExecutive Console” on page 8.|

Regardless of the panes that are displayed in the PowerExecutive window, you can
use the breadcrumb at the upper right of the window to determine the tree
structure of the component that is currently selected. You can also navigate back
up the tree structure to see information about higher-level objects. This is
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6

equivalent to collapsing the tree structure in the navigation pane or selecting a
higher-level tree element. To expand the tree structure, you must use the
navigation pane.

You can force the window to refresh in different ways, as explained in
the PowerExecutive Console” on page 9

Navigation pane

Use the navigation pane to select the power object for which the PowerExecutive
Console displays information.

The left side of the PowerExecutive Console contains the navigation pane, which
displays the systems currently targeted by PowerExecutive in a tree structure. Each
node in the structure represents an object that is managed by PowerExecutive.
There is always a root node with two child nodes:

* The root node is labeled All Systems if you launch the Console by
double-clicking the PowerExecutive task, or Selected Systems if you launch the
Console by targeting a specific group or system.

* One child node labeled Power-Managed Systems represents the group consisting
of all currently-targeted rack-mounted servers or BladeCenter chassis that
support power metering.

* The other child node labeled Other Systems represents the group consisting of all
currently-targeted rack-mounted servers that don’t support power metering.

Note: If the node labeled Other Systems is selected in the navigation tree, the
Summary table, Power Meter and Trend Data graph or table displays a
message that no information is available for that system.

When you expand an individual BladeCenter chassis within the navigation pane,
the tree structure shows folders that identify the power domains in the
BladeCenter chassis. Under each power domain folder are various components
within that power domain, such as the following objects:

* Power modules

* Blade servers

* I/0 modules

* Management modules
* Blower modules

* Media trays

* Midplanes

When you select one of these components, PowerExecutive updates the object
information pane and the trend pane to display information about the one that you
selected.

Detail pane

Use the detail pane to view information about a selected power object.
The upper right side of the window contains the detail pane, which use a table to
display information about the power object that is currently selected in the tree

structure.

The rows and columns in the table change with the power object that is selected.
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* If you select the root of the tree in the navigation pane and it represents an IBM
Director group, the detail pane displays rows about the BladeCenter chassis in
that group and columns with information about that chassis.

 If you select a BladeCenter chassis in the navigation pane, the detail pane
displays rows about the power domains in the chassis and columns with
information about those power domains.

* If you select a power domain in the navigation pane, the detail pane displays
rows about the power objects in that power domain and columns with
information about those power objects.

* If you select a power object within a power domain in the navigation pane, the
detail pane displays information about the fields and field values for that power
object.

For information about the columns and fields in the tables of the details pane, see
[“Monitoring power-consumption data” on page 15

PowerExecutive updates the information in the detail pane when new information
becomes available, which is generally once per data collection interval. The default
is every minute, but this data-collection interval can be customized. For more
information, see [“Managing collection of trend data” on page 23.

You can use PowerExecutive to export the information in the detail pane. For more
information, see either [“Exporting a trend table” on page 25|or [“Exporting a trend]
loraph” on page 25|

When the detail pane is displaying group, BladeCenter chassis, or power domain
information, the last row of the table provides a summary of the other information
in the table. Just the summary information in the detail pane can be exported by
PowerExecutive. For more information, see [“Exporting summary data” on page 24/

Trend pane

Use the trend pane to view information about current and historical power
consumption for a selected power object.

The lower right side of the window contains the trend pane, which provides a
power meter and either a tabular or a graphical view of power data over time
about the power object that is currently selected in the tree structure.

The watts shown in the power meter can represent alternating current (ac) or
direct current (dc) watts as follows:

* When the power meter is displayed for a power object, the watts in the power
meter represent dc watts.

* When the power meter is displayed for a group of chassis, a rack-mounted
server, an individual chassis, or a group, the watts in the power meter represent
ac watts.

The title for the power meter changes to represent the type of watts being
measured.

The time range for the displayed trend data is indicated by the trend data interval
list box. You can select one of the predefined data ranges or create a custom trend
data interval. For more information, see [’Creating a custom time interval for the|

ftrend pane” on page 24
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The predefined data ranges are as follows:

Last hour
Last 12 hours
Last 24 hours
Last 48 hours
Last week
Last 2 weeks

¢ Last month

¢ Last 6 months

¢ Last year

The check boxes above the trend data table or trend data graph enable you to
control the display of power in use, minimum and maximum power in use, and
event information. The values for each of these graphs is displayed in the trend
data graph in a different color. For the trend data table, this information is put into
cells of the table (see Table 1).

Table 1. Colors and meanings that are used in trend graph

Graph check
boxes

Displayed in trend graph
as

Description

Power in Use

Green line

Shows the power in use as reported by the
BladeCenter management module (MM).

Min and Max
Power in Use

Minimum power is shown
as a blue line while
maximum power is shown
as a red line

Shows the minimum power that the object
has consumed and the maximum power that
the object has consumed.

Events

Green triangles and yellow
diamonds

Shows the PowerExecutive events that have
occurred. Each event has a severity. For more
information, see [“Internal events” on page 27|

If the Power in Use and Min and Max Power check boxes are selected for display
and all three power values are the same, the combined line is red.

On the trend data graph, you can also select a time range graphically by using the
mouse to zoom in or out on the current view.

Customizing the PowerExecutive Console

You can customize the contents of the PowerExecutive Console.

You can control the display of these panes on the PowerExecutive Console:

* Navigation pane

¢ Detail pane
* Trend pane

To show or hide one of these panes, use the View menu to check or uncheck the
name of each pane.

When the trend pane is displayed, you can control its display as follows:

* Show or hide the power meter

* Show the trend data as a graph
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e Show the trend data as a table

To control these aspects of the trend pane, use the View menu to check or uncheck
each aspect you wish to control.

Refreshing the PowerExecutive Console

You can use the Refresh function to request an update of the information that is
shown in the PowerExecutive Console.

PowerExecutive obtains its information from persistent storage in IBM Director
Server and then caches the information on the console for subsequent display. See
[“Monitoring power-consumption data” on page 15 for the types of information
that is displayed by PowerExecutive.

By default, the Console view is refreshed automatically once per short-term
data-collection interval. The default is every minute, but you can this data
collection interval. To configure the short-term data collection interval, see
[“Managing collection of trend data” on page 23]

Additionally, certain events from Server Configuration Manager also cause
refreshes. For more information, see [“External events” on page 26/

The Configuration Manager Editor allows you to create and edit profiles that
include configuration settings for the components of chassis and servers, such as
switches and management modules.

However, with the Refresh function, you can force a refresh request rather than
waiting for the data collection interval or an event to occur.

To refresh the PowerExecutive Console, click the Refresh icon in the toolbar. If the
management server contains several power objects that are being displayed, the
refresh operation can take several minutes. Alternatively, you can use the View -
Refresh menu option.

During the refresh operation, the status line of the PowerExecutive Console
displays the word Refreshing to indicate that the operation is active. After the
refresh operation is complete, the status line displays the word Ready.

Invoking PowerExecutive functions

Operations are invoked in PowerExecutive primarily through the toolbar, the menu
bar or popup menus in the PowerExecutive Console.

You can use the menu bar to suspend and resume data collection, manage trend
data, export power information, derate power for individual power objects,
customize the contents of the PowerExecutive Console, access the PowerExecutive
help system, and close the PowerExecutive Console. Menu bar operations are
explained in |[Chapter 3, “Using PowerExecutive,” on page 15

The PowerExecutive toolbar contains the functions that are described in
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Table 2. Toolbar icons and their actions

Icon

Action

Hides the power meter in the trend pane. This icon is available only
when the power meter is displayed in the trend pane.

Displays the power meter in the trend pane. This icon is available
only when the power meter is not displayed in the trend pane.

Displays trend data in graphical format. This toolbar icon is
available only when the trend data is displayed in tabular format.

Displays trend data in tabular format. This toolbar icon is available
only when the trend data is displayed in graphical format.

Refreshes the entire tree structure in the navigation pane and
updates the power information in the detail and trend panes.

Suspends data collections. This toolbar icon is available only for
BladeCenter chassis objects whose data is actively collected by
PowerExecutive.

Resumes data collections. This toolbar icon is available only for
BladeCenter chassis objects whose data collection has suspended by
PowerExecutive.
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Chapter 2. Installing PowerExecutive

This chapter provides information about requirements, planning and preparation,
as well as instructions for installing and uninstalling PowerExecutive.

Requirements

This topic provides information about PowerExecutive product requirements.

In addition to the requirements that are applicable to IBM Director 5.10,
PowerExecutive has further restrictions regarding the hardware and software with
which it can be used. For information about IBM Director 5.10 requirements, see
the IBM Director Installation and Configuration Guide.

Hardware requirements

This section describes the minimum hardware requirements that must be met
when you install or use PowerExecutive.

Management servers and management consoles
PowerExecutive can be installed on any management server or management
console that supports IBM Director 5.10.

Managed systems
PowerExecutive can monitor the power objects in certain rack-mounted servers
and that are IBM Director level-0 managed systems:

PowerExecutive can monitor these BladeCenter chassis:
* BladeCenter machine type 8877
* BladeCenter 2 machine type 8852

Within a supported BladeCenter chassis, PowerExecutive can provide actual power
consumption information for the following blades:

* BladeCenter HS20, machine type 8843

* BladeCenter JS21, machine type 8844

* BladeCenter LS20, machine type 8850

* BladeCenter T, machine type 8720 and 8730

Note: PowerExecutive does not support any blade servers that do not have
power-metering support.

In a supported rack-mounted server, PowerExecutive can provide estimates of
power consumption for these servers:

e 1U rack server ----> x3550
e 2U rack server ----> x3650

Supported operating systems

PowerExecutive is supported for use with IBM Director 5.10 management servers
and management consoles that are running supported 32-bit operating systems.
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PowerExecutive supports a subset of the operating systems supported by IBM
Director. Specifically, these operating systems are supported for Power Executive:

* Red Hat Enterprise Linux AS and ES, version 4.0, for Intel® x86
» SUSE LINUX Enterprise Server 9 for x86
* Windows Server 2003, Enterprise, Standard, and Web Editions

Preparing to install PowerExecutive

Use this section to ensure that your environment is set up properly for the
installation and use of PowerExecutive.

Checking all prerequisites

Ensure that all prerequisites have been met before you install and use
PowerExecutive.

The following prerequisites are specific to PowerExecutive v1.10:
* IBM Director 5.1 is installed

* BladeCenter Management extension of IBM Director is installed

Downloading PowerExecutive

Use this section to ensure that your environment is set up properly for the
installation and use of PowerExecutive.

Complete the following steps to download PowerExecutive from the IBM Web site:

1. Go to the overview page for PowerExecutive at www.ibm.com/servers/
eserver/xseries/systems_management/ibm_director/ extensions/
powerexec.html

2. On the right side of the overview page, click the link for the download page.

3. From the download page, click the file link for the executable file that you
want to download.

lists the executable files that you can download.

Table 3. PowerExecutive files that can be downloaded

Operating | PowerExecutive
system component File to download

Windows Server or console |40k1484.exe

Linux Server PowerExecutive-server-1.1-1.noarch.rpm

Linux Console PowerExecutive-console-1.1-1.noarch.rpm

You should also download the IBM PowerExecutive 1.10 Release Notes and the
IBM PowerExecutive Installation and User’s Guide from this Web page.

4. Copy the downloaded file to a local drive on each management server and
management console on which you want to install PowerExecutive. Be sure
that you copy the correct file based on the operating system that the
management server or management console is using.

Installing PowerExecutive on systems running Windows

Use this section for installing PowerExecutive on systems that are running
Windows.
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If you are installing PowerExecutive on systems that are running Linux, see

[“Installing PowerExecutive on systems running Linux.”]

Complete the following steps to install PowerExecutive on a system that is running
Windows:

1.

6.

If IBM Director Server or IBM Director Console, or both, are running, close
them.

From the system on which you want to install PowerExecutive, run the
executable file that you downloaded.

Note: The operating-system account that is used to install PowerExecutive
must have at least local Administrator authority.

The PowerExecutive Setup program starts. After several seconds, the welcome
window opens.

Click Next. The License Agreement window opens.

Read the license agreement, click I accept the terms in the license agreement,
and click Next. The Ready to Install the Program window opens.

Click Install.

Note: If you are installing PowerExecutive Console or PowerExecutive Server
when IBM Director Server is not running, the Installing IBM
PowerExecutive window opens. The progress of the installation is
displayed.

Note: If this is an upgrade, and the existing PowerExecutive database is from a
prior release, then a warning prompt will occur that indicates that the
previous version of PowerExecutive will no longer be able to access the
database once version 1.10 has been started.

Click Finish.

Installing PowerExecutive on systems running Linux

This section provides instructions for installing PowerExecutive on systems that are
running Linux.

If you are installing PowerExecutive on systems that are running Windows, see

[‘Installing PowerExecutive on systems running Windows” on page 12.|

To install PowerExecutive on a Linux system:

On systems where you are installing PowerExecutive Server, enter the following
command at the command prompt:

rpm -Uv PowerExecutive-server-1.1-1.10noarch.rpm

On systems where you are installing PowerExecutive Console, enter the
following command at the command prompt:

rpm -Uv PowerExecutive-console-1.1-1.10noarch.rpm

Note: If you are installing PowerExecutive Server and IBM Director Server is

running, then this installation stops the IBM Director service before the
PowerExecutive installation begins. After the PowerExecutive installation is
completed, the IBM Director service is restarted.
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Uninstalling PowerExecutive on systems running Windows

Use these instructions for uninstalling PowerExecutive on systems that are running
Windows.

If you are uninstalling PowerExecutive on systems that are running Windows, see
[“Uninstalling PowerExecutive on systems running Windows.”]

Complete the following steps to uninstall PowerExecutive on systems that are
running Windows:

1. Click Start > Settings > Control Panel. The Control Panel window opens.

2. Double-click Add/Remove Programs. The Add/Remove Programs window
opens.

3. Click the currently installed program IBM PowerExecutive; then click
Change/Remove.

4. Follow any further instructions on the screen.

Uninstalling PowerExecutive on systems running Linux

14

Use these instructions for uninstalling PowerExecutive on systems that are running
Linux.

If you are uninstalling PowerExecutive from systems that are running Windows,
see [“Uninstalling PowerExecutive on systems running Windows.”]

To uninstall PowerExecutive from a Linux system:

* On systems where you are uninstalling PowerExecutive Server, enter the
following command at the command prompt:

rpm -ev PowerExecutive-server

* On systems where you are uninstalling PowerExecutive Console, enter the
following command at the command prompt:

rpm -ev PowerExecutive-console
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Chapter 3. Using PowerExecutive

This chapter provides information about using PowerExecutive to monitor and
collect power consumption data, manage trend data, and export data.

Monitoring power-consumption data

Use PowerExecutive to display details and summaries about both power-managed
systems and unmanaged systems.

Each node in the navigation tree of PowerExecutive represents an object that is
being managed. There is one top-level node with two children:

* Power-Managed Systems consist of all currently targeted rack-mounted servers or
BladeCenter chassis that support power metering.

* Other Systems consist of all currently targeted rack-mounted servers that don’t
support power metering.

Note: All BladeCenter chassis are considered to be power-managed, so chassis
cannot appear in this group.

You can display the following details and summaries about power-managed
systems:

* For a group of BladeCenter chassis or rack-mounted servers, you can display
details and summary information.

* For an individual BladeCenter chassis, you can display details and summary
information.

 For an individual rack-mounted server, you can display details.

* For an individual power domain, you can display details and summary
information.

* For an individual power object, you can display details.

Displaying details and summary information about a group of
BladeCenter chassis or rack-mounted servers

Use this section to display the details and summary information that
PowerExecutive provides about a group of BladeCenter chassis or rack-mounted
servers.

Complete the following steps to display details and summary information about a
group of BladeCenter chassis or rack-mounted servers:

1. From IBM Director Console, drag the PowerExecutive task onto a group of
chassis or rack-mounted servers.

2. In the navigation pane of the PowerExecutive Console, look at the information
in the detail pane.

Each row in the table corresponds to one BladeCenter chassis or rack-mounted
server in the group. All power numbers in the table represent alternating current
(ac) power.

The last row of the table summarizes information about the chassis or server in the
group.
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describes the information that is displayed for each chassis or server in the

group.

Table 4. Detail information about a group of BladeCenter chassis or rack-mounted servers

Column title

Description

Name

The name of the BladeCenter chassis or rack-mounted server.

Data Collection

The status of data collection. Values are Enabled, Disabled and Offline.

The offline status is used when data collection is enabled, but the
management module is not responsive. The offline status reflects only
whether the management module is responsive to PowerExecutive. It
is not an indicator of system health.

Watts in Use

The sum of the power in use by all power domains in the BladeCenter
chassis or rack-mounted server. This value is measured in watts.

If no value is displayed, then data to determine this value is
unavailable.

Nameplate Watts

The sum of the static maximum power of all power domains. This
value is measured in watts. The static maximum power is the
nameplate power as reported by VPD.

°C Ambient

The current ambient (inlet) temperature of the chassis. This value is
measured in Celsius degrees.

°C Exhaust

The current temperature of the air exiting the box. This value is
measured in Celsius degrees.

Acoustic Mode

Indicates whether acoustic mode is in use for the BladeCenter chassis.
Values are Enabled or Disabled. For information about acoustic mode,
see the documentation that comes with the management module that
is in the affected chassis.

BTUs/hr

An estimate, based on the power in use, of the thermal load in British
thermal units (Btu) placed on the surrounding environment by this
BladeCenter chassis or rack-mounted server.

The following formula is used to determine the estimate that is
displayed:
1 watt = 3412 Btu/hour

Summary Row

Totals for the following columns:
* Watts in Use

* Nameplate Watts

* BTU/hr

Displaying details and summary information about an
individual BladeCenter chassis

Use this action to describe the details and summary information that
PowerExecutive provides about an individual BladeCenter chassis.

Complete the following steps to display details and summary information about an
individual BladeCenter chassis:

1. From IBM Director Console, drag the PowerExecutive task onto a chassis.

2. In the navigation pane of the PowerExecutive Console, look at the information
in the detail pane.
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Each row in the table corresponds to one power domain in the BladeCenter
chassis. All power numbers in the table represent ac power.

The last row of the table summarizes information about the power objects in the
BladeCenter chassis.

describes the information that is displayed for each power object in a
BladeCenter chassis.

Table 5. Detail and summary information about an individual BladeCenter chassis

Column title Description
Name The name of the power object.
Watts in Use The sum of the power in use by all power objects in the power domain.

This value is measured in watts.

If no value is displayed, then data to determine this value is
unavailable.

Nameplate Watts | The sum of the static maximum power of all power domains in the
chassis. This value is measured in watts. The static maximum power is
the nameplate power as reported by VPD.

Redundancy The redundancy in the power domain. The following values are
Status available:

* Redundant Power Available
¢ Non-Redundant Power Available

* No Power Available

For information about power-management policy settings, including
redundancy in the power domain, see the documentation that comes
with the MM that is in the affected BladeCenter chassis.

Oversubscription | The oversubscription policy that the BladeCenter chassis is using. Values
Policy are one of the following:

* Redundant without Performance Impact
* Redundant with Performance Impact
* Non-Redundant

For information about oversubscription policies, see the documentation
that comes with the MM that is in the affected BladeCenter chassis.

Summary Row | Totals for the following columns:
* Watts in Use
* Nameplate Watts

Displaying details and summary information about individual
power domains

Use this action to display the details and summary information that
PowerExecutive provides about an individual power domain within a BladeCenter
chassis.

Complete the following steps to display details and summary information about an
individual power domain:

1. From IBM Director Console, drag the PowerExecutive task onto the
BladeCenter chassis that contains the power domain.

Chapter 3. Using PowerExecutive 17



18

2. In the navigation pane of the PowerExecutive Console, expand the tree
structure until you see the power domain.

3. Click the name of the power domain and look at the information in the detail

pane.

Each row in the table corresponds to one bay, which is generally one power object,
within the power domain. The power numbers for modules in the table represent

dc power.

The last row of the table summarizes information about the power objects in the
power domain. The power numbers in the summary row represent ac power.

describes the information that is displayed for each power object in a

power domain.

Table 6. Detail information about power objects in a power domain

Column title

Description

Name

The name of the power object.

Type

The type of power object. The following values are available:

* Power Module
Note: The power consumption listed for the power module represents
the amount of power lost in the power module.

 Blade Server

* I/O Module

* Management Module
* Blower Module

* Media Tray

* Midplane

Bay

The number of the bays that this power object occupies.

Power Meter
Supported

(Blade servers only) Indicates whether a power meter is enabled on this
processor. Values are Yes and No.

Watts in Use

The power in use of the power object.

* For a blade server that has the power meter enabled, this column
displays the actual watts being consumed as reported by the power
meter.

If no value is displayed, then data to determine this value is
unavailable.

* For all other blade servers and all power objects, this column displays
the same value as that displayed by the Static Max Power as Configured
column, reduced by the derating percentage. For more information, see
[‘Setting the derating power factor” on page 22|

In both cases, this value is measured in watts.

Nameplate
Watts

The nameplate power as reported by VPD.
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Table 6. Detail information about power objects in a power domain (continued)

Column title

Description

Max Watts

The maximum watts consumed during the current measurement interval.

* For a blade that has the power meter enabled, this column displays the
value as reported by the power meter.

If no value is displayed, then data to determine this value is
unavailable.

* For all other blades and all power objects, this column displays the
same value as that displayed by the Static Max Power as Configured
column.

In both cases, this value is measured in watts.

Max Time

(Blade servers that have the power meter enabled only) The time at which
the maximum power value was recorded.

If no value is displayed, then data to determine this value is unavailable.

Summary Row

The totals of the following columns:
e Watts in Use
* Nameplate Watts

Displaying details about individual power objects

Use this action to describe the details that PowerExecutive provides about
individual power objects.

Complete the following steps to display details about an individual power object:

1. From IBM Director Console, drag the PowerExecutive task onto the
BladeCenter chassis that contains the power object.

2. In the navigation pane of the PowerExecutive Console window, expand the tree
structure until you see the power object.

3. Click the name of the power object and look at the information in the detail

pane.

Each row in the table corresponds to one power object in the BladeCenter chassis.

describes the information that is displayed for an individual power object.
The power numbers in the table represent dc power.

Table 7. Detail information about an individual power object

Field name

Description

Name The name of the power object. No value is displayed when the bay
is not populated.
Type The type of power object. The following values are available:

* Power Module
Note: The power consumption listed for the power module
represents the amount of power lost in the power module.

 Blade Server

* 1/0O Module

* Management Module
* Blower Module

* Media Tray

* Midplane
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Table 7. Detail information about an individual power object (continued)

Field name

Description

Bay

The number of the bay that this power object occupies.

Power Meter
Supported

Indicates whether a power meter is enabled on this processor. For
a blade server, values are Yes and No. For any other power object,
the value is always No. No value is displayed when the bay is not
populated.

Watts in Use

The power in use of the power object.

* For a blade server that has the power meter enabled, this
column displays the actual watts being consumed as reported
by the power meter.

If no value is displayed, then data to determine this value is
unavailable.

¢ For all other blade servers and all power objects, this column
displays the same value as that displayed by the Label Power
column, reduced by the derating percentage.

In both cases, this value is measured in watts.

Nameplate Watts

The nameplate power as reported by VPD.

Derate Nameplate
Watts to (%)

The percentage of the static maximum power to use when
estimating the power in use for blade servers that have not
enabled the power meter and for all other power objects. The
default value is 100%, which means that the static maximum
power is not reduced when used as an estimate for the power in
use.

Max Watts

The maximum watts consumed during the current measurement
interval.

 For a blade server that has the power meter enabled, this
column displays the value as reported by the power meter.

If no value is displayed, then data to determine this value is
unavailable.

¢ For all other blade servers and all power objects, this column
displays the same value as that displayed by the Label Power
column.

In both cases, this value is measured in watts.

Max Time

(Blade servers that have the power meter enabled only) The time
at which the maximum power value was recorded.

If no value is displayed, then data to determine this value is
unavailable.

Current CPU Throttle
Values (%)

(Blade server only) A comma-separated list of the current throttle
values of each processor in the blade server. A value of 100%
indicates that a processor is running at maximum performance
(full throttle). For information about throttle levels, see the
documentation that comes with the BladeCenter management
module that is in the affected chassis.

Preset Blade Throttle
Value (W)

(Blade server only) The preset throttle level of the BladeCenter
chassis that contains this power object. For information about
throttle levels, see the documentation that comes with the
BladeCenter MM that is in the affected chassis.
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Displaying details about power-managed rack-mounted
servers

Use this action to describe the details that PowerExecutive provides about
power-managed rack-mounted servers.

Complete the following steps to display details about a power-managed
rack-mounted server:

1. From IBM Director Console, drag the PowerExecutive task onto the object that
contains the server.

2. In the navigation pane of the PowerExecutive Console window, expand the tree
structure until you see the server.

3. Click the name of the rack-mounted server, and look at the information in the
detail pane.

Each row in the table corresponds to one power object in the power-managed
server.

Table 8. Detailed information about a power-managed rack-mounted server

Field name Description

Name The name of the server.

Power Meter Indicates whether a power meter is enabled on this processor.

Supported Values are Yes and No.

Watts in Use The sum of the power in use by all power objects in the power
domain. This value is measured in watts.

Nameplate Watts The nameplate power as reported by VPD.

Max Watts The maximum watts consumed during the current measurement

interval, as reported by the power meter, or "-" if
maximum-power data is not available.

Max Time The time at which the Max Watts value was recorded, or "-" if
maximum-power data is not available.

Displaying details about unmanaged rack-mounted servers

Use this action to display the details that PowerExecutive provides about
unmanaged rack-mounted servers.

Complete the following steps to display details about an unmanaged rack-mounted
server:

1. From IBM Director Console, drag the PowerExecutive task onto the object that
contains the server.

2. In the navigation pane of the PowerExecutive Console window, click Other
Systems to expand the tree structure until you see the server.

3. Click the name of the rack-mounted server and look at the information in the
detail pane.

Each row in the table corresponds to an unmanaged server.

Table 9. Detailed information about an unmanaged rack-mounted server

Field name Description

Name The name of the rack-mounted server
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Table 9. Detailed information about an unmanaged rack-mounted server (continued)

Field name Description

Upgradeable "Yes" if the server could become power-managed with a firmware
upgrade; "No” if not.

Setting the derating power factor

You can set the derating power factor for an individual power object. By default,
the derating power factor is 100%, which means that the reported power is not
derated at all.

The derating factor is the percentage of the static maximum power that is used
when estimating the power in use for blade servers that are not power meter
enabled and for all other power objects. The derating factor does not apply to
power objects when information about the actual power consumed is available
from the BladeCenter management module.

Complete these steps to set the derating factor:
1. From IBM Director Console, start PowerExecutive.

2. In the navigation pane, select the power object that you want to derate. You
cannot derate power for a chassis or a power domain, you must select a
lower-level power object.

3. From the PowerExecutive window, click Edit » Derate Power. The
PowerExecutive Derate Power Factor window opens.

4. From the PowerExecutive Derate Power Factor window, enter a number that
represents the percent of the static maximum power that you want to use when
estimating the power consumption of the power object.

5. Click OK.

Collecting power consumption data

22

This section provides information about using PowerExecutive to collect power
consumption data.

By default, power information is collected for all BladeCenter chassis objects or
rack-mounted servers or both that are displayed in PowerExecutive.

Suspending data collection

You can suspend data collection on any chassis displayed in PowerExecutive.

You might decide to suspend data collection to decrease the amount of disk space
required in the PowerExecutive database. Another reason might be to reduce the
network load from polling for new information about power objects within a
chassis.

Data collection cannot be suspended for individual power objects within a chassis.

Complete these steps to suspend data collection for a chassis or a server:
1. From IBM Director Console, start PowerExecutive.

2. In the navigation pane of the Power Executive Console, select the chassis for
which you want to suspend data collection.

3. From the PowerExecutive Console, click Edit »+ Suspend Data Collection.
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Resuming data collection

You can resume data collection for a chassis displayed in PowerExecutive in which
data collection was previously suspended.

Resuming data collection increases the amount of disk space required in the
PowerExecutive database. It also increases the network load as it polls for new
information about the power objects within the chassis.

Complete these steps to resume data collection for a chassis:
1. From IBM Director Console, start PowerExecutive.

2. In the navigation pane of the PowerExecutive Console, select the chassis for
which you want to resume data collection.

3. From the PowerExecutive Console, click Edit ®+ Resume Data Collection.

Managing trend data

This section provides information about using PowerExecutive to manage trend
data.

Trend data is displayed in the trend pane of the PowerExecutive console. For more
information, see|“Trend pane” on page 7.|

Managing collection of trend data

You can manage trend data using the Edit menu of PowerExecutive.

Historical trend data is written to the PowerExecutive database. You can control
how often and how much historical trend data is written to the database and when
trend data is deleted .

However, when the PowerExecutive database cannot expand, it deletes the oldest
historical data from the database to free up room for new data that it is collecting.

Complete these steps to affect the trend data written to the PowerExecutive
database:

1. From IBM Director Console, start PowerExecutive.

2. From the Power Executive Console, click Edit * Manage Trend Data. The
Manage Trend Data window opens.

3. Complete the fields on the Manage Trend Data window as follows:

e In the Short-term data collection interval in minutes field, enter the number
of minutes in the short-term data-collection cycle. The default value is one
day.

Once every short-term data-collection interval, PowerExecutive collects
temperature and power data from the systems under its control. Each
short-term data collection interval, PowerExecutive checks each bay to see if
it is populated, and if it is occupied by a power object that is different from
the last data collection. The data collected during these cycles is considered
to be short-term data collection. Lower values in this field could have an
impact on the network performance of the systems involved.

* In the Long-term data collection interval in minutes field, enter the number
of minutes in the long-term data collection cycle. The default value is ten
days. PowerExecutive uses the long-term data collection cycle to determine
which data is considered to be long-term data. Long-term data is the trend
data that you can be display on the trend pane.
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* In the Number of days to keep short-term trend data field, enter the
number of days that PowerExecutive identifies data as short-term data before
considering it to be long-term data. The default value is 31 days.

* In the Number of days to keep long-term trend data field, enter the number
of days that PowerExecutive keeps long-term data before deleting it. The
default value is 365 days.

4. Click OK.

Creating a custom time interval for the trend pane

You can create a custom time interval for use by the trend pane instead of using
one of the predefined time intervals.

Complete the following steps to create a custom time interval for the trend pane:
e From IBM Director Console, start PowerExecutive.

* From the trend pane in the PowerExecutive window, click Custom as the trend
data interval. The PowerExecutive Custom window opens.

* Complete the fields on the PowerExecutive Custom window as follows:
— In the first row of fields, enter the day and time from which the trend data

should start. You need to define the month, day, year, hour and minute from
which to start displaying trend data.

— In the second row of fields, enter the day and time at which the trend data
should stop. You need to define the month, day, year, hour and minute at
which to stop displaying trend data.

* Click OK.

Exporting data from PowerExecutive

Use this section to get information about exporting data from PowerExecutive.

You can export the following types of data:
e Summary data from the details pane

* Power metering data from the trend pane
* Trend graph from the trend pane

* Trend table from the trend pane

Exporting summary data

Use the File menu in PowerExecutive to export summary data from the detail
pane.

PowerExecutive can save the exported summary data in comma-separated value
(CSV), XML or HTML format.

Complete the following steps to export the summary data in the detail pane:
1. From IBM Director Console, start PowerExecutive.

2. From the PowerExecutive Console, click File » Export * Summary Table. The
Export Summary Table window opens.

Select the directory where you want to export the data.

In the File Name field, type a name for the file.

In the Files of Type field, select the type of file that you want to create.
Click OK.

ook w
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Exporting the power meter data

Use the File menu in PowerExecutive to export the power meter data from the
trend pane.

PowerExecutive saves the exported power meter data in JPEG format.

Complete the following steps to export the power meter data:
1. From IBM Director Console, start PowerExecutive.

2. From the PowerExecutive console, click File » Export + Power Meter. The
Export Power Meter window opens.

3. Select the directory where you want to export the data.
4. In the File Name field, type a name for the file.
5. Click OK.

Exporting a trend graph

Use the File menu in PowerExecutive to export a trend graph from the trend pane.
PowerExecutive saves the exported trend graph in JPEG format.

Complete the following steps to export the trend graph:
1. From IBM Director Console, start PowerExecutive.

2. From the PowerExecutive Console, click File » Export » Trend Graph. The
Export Trend Graph window opens.

3. Select the directory where you want to export the data.
4. In the File Name field, type a name for the file.
5. Click OK.

Exporting a trend table

Use the File menu in PowerExecutive to export a trend table from the trend pane.
Power Executive can save the exported trend table in CSV, XML or HTML format.

Complete the following steps to export the data in a trend table:
1. From IBM Director Console, start PowerExecutive.

2. From the PowerExecutive Console, click File » Export » Trend Table. The
Export Trend Table window opens.

Select the directory where you want to export the data.

In the File Name field, type a name for the file.

In the Files of Type field, select the type of file that you want to create.
Click OK.
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Understanding events that affect PowerExecutive

This section provides information about the IBM Director events and
PowerExecutive events that affect the information that is displayed in
PowerExecutive.

Before using PowerExecutive, you should use the Management Processor

Configuration subtask of the Server Configuration Manager task (formerly
Management Processor Assistant [MPA] to configure an alert-forwarding profile for
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the chassis that contain the power objects that you plan to monitor. In the
alert-forwarding profile, the connection type must be set to IBM Director
Comprehensive and the IP address must be set to the IP address of the
management server that is being used to monitor power consumption with
PowerExecutive. Further, this management server must be the only server that is
configured and enabled to receive alerts from the chassis that you plan to target.

If an alert-forwarding profile is not created for a chassis, PowerExecutive cannot
receive any events for that chassis.

Note: The IBM Director event log might not contain all events that are reported in
PowerExecutive. Further, the timestamp on events is different between the
IBM Director event log and the trend pane in Power Executive. The IBM
Director event log records the time that the defect occurred. The
PowerExecutive events reflect the time that PowerExecutive detected the
event.

External events

Some events from Server Configuration Manager cause PowerExecutive to poll for
new information and refresh the PowerExecutive Console as needed. Server
Configuration Manager is an IBM Director task that is used to create or update
server configuration profiles, which include management of service processors in
System x and IBM Netfinity® servers.

able 10 describes the severities that can be assigned to each event.

Table 10. Event severities and their meanings

Event
severity | Description

Critical Severe events that signal that the system might not be functioning.

Warning | Serious events that could progress to critical severity.

Harmless | Any event that is not severe or serious. These events are not necessarily errors.

able 11| describes the events that can cause refreshes of the information in the
PowerExecutive Console.

Table 11. Events that affect the information in PowerExecutive

Severity | Category Description
Critical Multiple Blower Both blowers in the system failed.
Failure
Critical Power Failure A system power supply failed.
Critical Temperature A monitored temperature exceeded its critical threshold

value. (If a critical temperature condition is detected on
a blade server, the blade server is automatically shut

down.)
Critical Multiple I/O Multiple I/O modules failed or were removed.
Module Failure
Warning | Single Blower One blower failed.
Failure
Warning | Temperature A monitored temperature exceeded its warning

threshold value. (This event does not initiate an
automatic system shutdown.)
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Table 11. Events that affect the information in PowerExecutive (continued)

Severity | Category Description
Warning |Redundant Module |A redundant module failed or was removed.
Failure

Warning | Blade Throttle A BladeCenter is throttled in order to maintain a power
consumption within certain bounds. A recovery event is
also sent.

Warning | Power Management |A power-management event was detected, such as
mismatched power modules in a power domain,
demand exceeding capacity in a domain, or components
not being allowed to turn on due to insufficient power.

Warning | Change In The BMC goes from not supporting power metering to

Power-management |supporting power metering or vice versa.
State

Warning | Restart MM The Management Module (MM) will reset.

Harmless |Power-On A blade server or I/O module was turned on.

Harmless |Power-Off A module in the system was turned off.

Internal events
PowerExecutive displays information about events that it generates in the trend

pane.

Specifically, PowerExecutive generates and displays event information with the
following severities:

* These events have a warning severity:

— Stopping PowerExecutive Server

— Suspending data collection for a BladeCenter chassis

— Offline status of a BladeCenter chassis

— Removal of a module from a BladeCenter chassis

— Long-term data deleted from PowerExecutive database

* These events have a harmless severity:

— Start of PowerExecutive Server

— Resume status of data collection for a BladeCenter chassis

— Online status of a BladeCenter chassis

— Insertion of a module from a BladeCenter chassis
— Addition of a BladeCenter chassis
— Enable or disablement of acoustic mode

— Changes to the oversubscription policy

— Short-term data coalesced

Events that PowerExecutive generates are collected with other trend data and
stored in the PowerExecutive database. These events let you know why historical
data might be missing for one or more chassis.

In the trend graph, these events are displayed as follows:

* Events with a critical severity are shown as red squares.

* Events with a warning severity are shown as yellow diamonds.

* Events with a harmless severity are shown as green triangles.
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You can place your mouse over each event in the trend graph to obtain a
description of the event that occurred.

In the trend table, these events are displayed in the Event column.
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Chapter 4. Troubleshooting

Use this section to troubleshoot and resolve problems with PowerExecutive.

Contacting customer support

If you need help, service or technical assistance or just want more information
about IBM products, you can find a wide variety of sources available from IBM to
assist you. This section contains information about where to go for additional
information about IBM and IBM products, what to do if you experience a problem
with your System x system, and whom to call for service, if it is necessary.

Before you call

Before you call, make sure that you have taken these steps to try to solve the

problem yourself:

* Check all cables to make sure that they are connected.

¢ Check the power switches to make sure that the system is turned on.

* Use the troubleshooting information in your system documentation, and use the
diagnostic tools that come with your system. Information about diagnostic tools

is in the Hardware Maintenance Manual and Troubleshooting Guide on the IBM
System x Documentation or at the IBM Support Web site.

* Go to the IBM Support Web site at [www.ibm.com /pc/support /| to check for
technical information, hints, tips, and new device drivers or to submit a request
for information.

You can solve many problems without outside assistance by following the
troubleshooting procedures that IBM provides in the online help or in the
publications that are provided with your system and software. The information
that comes with your system also describes the diagnostic tests that you can
perform. Most System x systems, operating systems, and programs come with
information that contains troubleshooting procedures and explanations of error
messages and error codes. If you suspect a software problem, see the information
for the operating system or program.

Using the documentation

Information about your IBM System x system and preinstalled software, if any, is
available in the documentation that is included with your system. That
documentation includes printed books, online books, readme files and help files.
See the troubleshooting information in your system documentation for instructions
for using the diagnostic programs. The troubleshooting information or the
diagnostic programs might tell you that you need additional or updated device
drivers or other software. IBM maintains pages on the World Wide Web where you
can get the latest technical information and download device drivers and updates.
To access these pages, go to www.ibm.com /pc/support/| and follow the
instructions. Also, you can order publications through the IBM Publications
Ordering System at[www.elink.ibmlink.ibm.com /public/applications/publications //

Iggibin / pbi.cgil
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Getting help and information from the World Wide Web

On the World Wide Web, the IBM Web site has up-to-date information about IBM
System x products, services and support. The address for IBM System x
information is www.ibm.com/systems/x.

You can find service information for your IBM products, including supported
options, at www.ibm.com/pc/support/.

Software service and support

Through IBM Support Line, you can get telephone assistance, for a fee, with usage,
configuration, and software problems with System x servers, workstations and
appliances. For information about which products are supported by Support Line
in your country or region, go to www.ibm.com/services/sl/products/.

For more information about Support Line and other IBM services, go to

www.ibm.com/services/, or go to www.ibm.com/planetwide/ for support
telephone numbers. In the U.S. and Canada, call 1-800-IBM-SERV (1-800-426-7378).

30 IBM PowerExecutive Installation and User's Guide



Appendix. Notices
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
MWO9A /050

5600 Cottle Road
San Jose, CA 95193
US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs.
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Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows: © (your company name) (year). Portions of
this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp.

_enter the year or years_. All rights reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks

The following are trademarks of International Business Machines Corporation in
the United States, other countries, or both:

BladeCenter
eServer

IBM
IntelliStation®
Netfinity
PowerExecutive
ServeRAID™
ServerProven

x System

Intel is a registered trademark of Intel Corporation or its subsidiaries in the United
States and other countries.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft and Windows are registered trademarks of Microsoft Corporation in the
United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of
others.
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Glossary

Terms

This topic provides definitions of terms that are
used in the PowerExecutive product.

A

ac See alternating current.

alternating current
An electric current that reverses its
direction at regularly recurring intervals.

B

Baseboard Management Controller
A controller that monitors system
platform management events such as fan
failure and temperature or voltage
increases, and logs their occurrence.

blade server
An IBM BladeCenter server. A
high-throughput server on a card that
supports symmetric multiprocessors
(SMP).

BladeCenter chassis
A BladeCenter unit that acts as an
enclosure. It enables the individual blade
servers to share resources such as the
management, switch, power and blower
modules.

BMC See Baseboard Management Controller.

British thermal unit
An English unit of measure for heat
produced in one hour.

BTU  See British thermal unit.

chassis
The metal frame in which various
electronic components are mounted.
dc See direct current.

direct current
An electric current that flows in a single
direction and at a constant voltage.

© Copyright IBM Corp. 2005, 2006

discovery
The process of finding resources within
an enterprise, including finding the new
location of monitored resources that were
moved.

event An occurrence of significance to a task or
system, such as the completion or failure
of an operation. There are two types of
events: alert and resolution.

event action
The action that IBM Director takes in
response to a specific event or events

event-action plan
A user-defined plan that determines how
IBM Director manages certain events. An
event action plan comprises one or more
event filters and one or more customized
event actions.

Event Action Plan wizard
An IBM Director Console wizard that can
be used to create simple event action
plans.

event filter
A filter that specifies the event criteria for
an event action plan. Events must meet
the criteria specified in the event filter in
order to be processed by the event action
plan to which the filter is assigned to.

extension
See IBM Director extension.

G

group A logical set of managed objects. Groups
can be dynamic, static, or task-based.

IBM Director Console
A component of IBM Director software.
When installed on a system, it provides a
graphical user interface (GUI) for
accessing IBM Director Server. IBM
Director Console transfers data to and

from the management server using
TCP/IP.
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IBM Director environment
The complex, heterogeneous environment
managed by IBM Director. It includes
systems, BladeCenter chassis, software,
Simple Network Management Protocol
(SNMP) devices.

IBM Director extension
A tool that extends the functionality of
IBM Director. Some of the IBM Director
extensions are BladeCenter Management,
Capacity Manager, ServeRAID Manager,
Remote Deployment Manager, and
PowerExecutive.

IBM Director Server
The main component of IBM Director
software. When installed on the
management server, it provides basic
functions such as discovery of managed
systems, persistent storage of
configuration and management data, an
inventory database, event listening,
security and authentication, management
console support, and administrative tasks.

L

Level-0 managed system
An IBM or non-IBM server, desktop
computer, workstation, or mobile
computer that can be managed by IBM
Director but does not have any IBM
Director software installed on it.

M

managed group
A group of systems or objects managed
by IBM Director.

managed object
An item managed by IBM Director. In
IBM Director Console, a managed object
is represented by an icon that shows its
type (such as chassis, cluster, system, or
scalable system).

managed object ID
A unique identifier for each managed
object. It is the key value used by IBM
Director database tables.

managed system
A system that is being controlled by a
given system management application, for
example, a system managed by IBM
Director.
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management console
A system (server, desktop computer,
workstation, or mobile computer) on
which IBM Director Console is installed.

management module
The BladeCenter component that handles
system-management functions. It
configures the chassis and switch
modules, communicates with the blade
servers and all I/O modules, multiplexes
the keyboard/video/mouse (KVM), and
monitors critical information about the
chassis and blade servers.

management server
The server on which IBM Director Server
is installed.

module
A BladeCenter component that is inserted
in a bay in a chassis and whose power
consumption data can be monitored by
PowerExecutive. Modules include power
modules (power supplies), blade servers,
I/0 modules, BladeCenter management
modules, blower modules, and media
trays.

(o)

out-of-band communication
Communication that occurs through a
modem or other asynchronous
connection, for example, service processor
alerts sent through a modem or over a
LAN. In an IBM Director environment,
such communication is independent of
the operating system and interprocess
communication (IPC).

P

power object
An IBM Director managed object that can
be managed by PowerExecutive. A power
object can be a group, a BladeCenter
chassis, a power domain, or a module.

R

rack-mounted server
A standalone system with a Baseboard
Management Controller (BMC).

S

switch module
The BladeCenter component that provides



network connectivity for the BladeCenter
chassis and blade servers. It also provides
interconnectivity between the
management module and blade servers.

system
The computer and its associated devices
and programs.

T

target system
A managed system on which an IBM
Director task is performed.

\'}

vital product data (VPD)
Information that uniquely defines the
system, hardware, software, and
microcode elements of a processing
system.

VPD  See vital product data.
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Index
A

accessibility  viii
keyboard  viii
shortcut keys  viii

alert-forwarding profile 25

bay 6
breadcrumb 5

C

chassis
displaying details 16
collect
data 22
trend 23

components 2
critical events 26
custom time interval 24

D

data
collection 22
resuming 9, 23
suspending 9, 22
trend data 23
exporting 24
derating power factor 22
detail pane 6
displaying 8
details, displaying 15
chassis 16
group of chassis 15
power domains 17
power objects 19
disability viii
downloading PowerExecutive 12

E

estimating
power consumption 22
events
refresh operations 26
trend pane 27
export
data 24
power meter 25
summary data 24
trend graph 25
trend table 25

G
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group of chassis
displaying details 15

H

hardware
requirements 11

IBM Web sites vii

installation 11, 13
downloading PowerExecutive 12
prerequisites 12

K

keyboard  viii

L

legal notices 31

M

Manage Trend Data window 23
Management Processor Assistant 26
module 6

monitoring power consumption 15

N

navigation pane 6
displaying 8

o)

operating system
supported 12

P

polling interval 23
power domains
displaying details 17
Power Executive
components of 1
concepts 1
documentation vii
getting started 1
overview 1
Power Executive Console 3
Power Executive Custom window 24
Power Executive Derate Power Factor
window 22
Power Executive window
customizing 8

Power Executive window (continued)
navigation pane 6
refreshing 9
trend pane 7

power meter 7
displaying 8, 9
exporting 25

power objects
derating 22
displaying details 19

PowerExecutive
database 3
prerequisites 12
uninstalling

Linux 14
Windows 14

PowerExecutive Console
events 26

PowerExecutive Server 3

PowerExecutive window 5
detail pane 6

problem solving 29

R

refresh 9
requirements 11
hardware 11
resume
data collection 9, 23

S

Server Configuration Manager events 26

shortcut keys viii
solving problems 29
summary data

exporting 24
summary, displaying 15
suspend

data collection 9, 22
system events 26

T

toolbar 9
trademarks 33
trend graph 7
displaying 8, 9
exporting 25
trend pane 7
custom time interval 24
displaying 8
events 27
predefined time intervals 7
trend table 7
displaying 8,9
exporting 25
troubleshooting 29



U

uninstalling Power Executive
Linux 14

uninstalling PowerExecutive
Windows 14

W

warning events 26
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